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Chapter 1: Release Notes

Chapter 1

Release Notes
What's New
The What's New is available on the Xilinx® website at Vivado® 2021.1 What's New.

Known Issues
Vivado Design Suite Tools Known Issues can be found at AR#76539.

Important Information
Licensing
The Vivado 2021.1 and beyond releases introduce the following changes in licensing that are
listed below:
• Flexera version for license management tool has been upgraded to 11.17.2.0.
• Anyone using floating license will require to upgrade licensing utilities to Flex 11.17.2.0. These
new licensing utilities are available on the Xilinx Downloads Website.
Note: Flex version upgrade does not affect valid license files, in other words, existing valid license files will
work with the Vivado 2021.1 release after you upgrade the licensing utilities.

Installer
Installer Changes:
The 2020.2 release introduced the new HLS product with support for both Vitis™ and Vivado®.
As part of this the overall folder structure changes, whereby the Vitis_HLS folder is now at the
same root location as Vivado® and Vitis™. You may need to update any custom setup scripts
from the previous release.
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The Xilinx 2021.1 settings.sh scripts will automatically handle this.

Vivado Naming Conventions
The following are the required naming conventions when working with the Vivado Design Suite.
Failing to follow these naming conventions might introduce potential risk to the design or the
tool, and cause unpredictable behavior in the design flow.
• Source files names must start with a letter (A-Z, a-z) and must contain only alphanumeric
characters (A-Z, a-z, 0-9) and underscores (_).
• Output files names must start with a letter (A-Z, a-z) and must contain only alphanumeric
characters (A-Z, a-z, 0-9) and underscores (_).
• Project names must start with a letter (A-Z, a-z) and must contain only alphanumeric
characters (A-Z, a-z, 0-9) and underscores (_).
• Project directory names must start with a letter (A-Z, a-z) and should contain only
alphanumeric characters (A-Z, a-z, 0-9), tilde (~) and underscores (_).
CAUTION! The Windows operating system has a 260 character limit for path lengths which can affect the
Vivado tools. To avoid this issue, use the shortest possible names and directory locations when creating
projects, defining IP or managed IP projects, or creating block designs.

The following characters are not supported for project, file, or directory names:
• !#$%^&*()`;<>?,[]{}'"|
• tab (\t)
• return (\r)
• new line (\n)
• / or \ (As part of the directory or file name rather than as a path delimiter)
The following character is not supported for directory names:
• . (dot as terminal character)
The following character is not supported for file or project names:
• @
Note: In the Vivado IDE, the @ character is not supported for new file or project names. The Vivado IDE
does allow an existing file on disk that uses the @ character to be added to a project. The Vivado IDE
can open a project that includes the @ character in the project name. Using the Tcl Console, you can
create a project with a name that contains the @ character.
IMPORTANT! Spaces in directory and file names are supported by the Windows operating system.
However, you should avoid using spaces in order to preserve portability of the project or files between the
Windows and Linux operating systems.
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The Vivado Design Suite supports the use of forward slashes (/) as path delimiters for both
Windows and Linux platforms. Backslashes (\) are allowed as path delimiters on the Windows
platform only.
Any characters not explicitly mentioned above are not supported for project, file, or directory
names.

Vivado Design Suite Documentation Update
In the 2021.1 Vivado Design Suite Documentation release, not all documentation will be
available at first customer ship. Use the Update Catalog button in DocNav to stay up-to-date
with the 2021.1 documentation suite.

Navigating Content by Design Process
Xilinx® documentation is organized around a set of standard design processes to help you find
relevant content for your current development task. All Versal™ ACAP design process Design
Hubs can be found on the Xilinx.com website. This document covers the following design
processes:
• Hardware, IP, and Platform Development: Creating the PL IP blocks for the hardware
platform, creating PL kernels, functional simulation, and evaluating the Vivado® timing,
resource use, and power closure. Also involves developing the hardware platform for system
integration. Topics in this document that apply to this design process include:
• What's New
• Supported Devices
• System Integration and Validation: Integrating and validating the system functional
performance, including timing, resource use, and power closure. Topics in this document that
apply to this design process include:
• What's New
• Supported Devices
• Board System Design: Designing a PCB through schematics and board layout. Also involves
power, thermal, and signal integrity considerations. Topics in this document that apply to this
design process include:
• What's New
• Supported Devices
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Chapter 2

Requirements and Setup
Supported Operating Systems
Xilinx® supports the following operating systems on x86 and x86-64 processor architectures.
• Microsoft Windows Professional/Enterprise 10.0 1809 Update; 10.0 1903 Update; 10.0 1909
Update; 10.0 2004 Update
• Red Hat Enterprise Workstation/Server 7.4, 7.5, 7.6, 7.7, 7.8, 7,9, 8.1, 8.2, and 8.3 (64-bit),
English/Japanese
• CentOS 7.4, 7.5, 7.6, 7.7, 7.8, 8.1, 8.2, and 8.3 (64-bit), English/Japanese
• SUSE Linux Enterprise 12.4 and 15.2 (64-bit), English/Japanese
• Amazon Linux 2 AL2 LTS (64-bit)
• Ubuntu Linux 16.04.5 LTS;16.04.6 LTS; 18.04.1 LTS; 18.04.2 LTS, 18.04.3 LTS; 18.04.4 LTS;
and 20.04 LTS, 20.04.1 LTS (64-bit), English/Japanese
Note: Please refer to PetaLinux Tools Documentation: Reference Guide (UG1144) for more information on
Installation Requirements for supported Operating Systems with PetaLinux.

Supported Devices
The following sections list architecture support for commercial products in the Vivado® Design
Suite ML Standard Edition tool versus all other Vivado Design Suite editions. For non-commercial
support all Xilinx Automotive devices are supported in the Vivado Design Suite ML Standard
Edition when available as production devices in the tools.
Note: Alveo™ and Kria™cards are included as part of the ML Standard Edition.
Note: Starting in Vivado 2016.x onward, a license is no longer required for Vivado ML Standard Edition.
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Table 1: Architecture Support
Device
Zynq®

Zynq® UltraScale+™ MPSoC

Zynq UltraScale+ RFSoC
Virtex FPGA

Vivado ML Standard Edition

Vivado ML Enterprise Edition
Zynq-7000 SoC Device

Zynq-7000 SoC Device

•

XC7Z010, XC7Z015, XC7Z020,
XC7Z030, XC7Z007S, XC7Z012S, and
XC7Z014S
XCZU2EG, XCZU2CG, XCZU3EG,
XCZU3CG XCZU4EG, XCZU4CG,
XCZU4EV, XCZU5EG, XCZU5CG,
XCZU5EV, XCZU7EV, XCZU7EG, and
XCZU7CG

UltraScale+ RFSoC

•

None

Virtex-7 FPGA

•

None

Virtex UltraScale FPGA

•

None

All

UltraScale+ MPSoC

UltraScale+ MPSoC

•

•

•

All

UltraScale+ RFSoC

•

All

Virtex-7 FPGA

•

All

Virtex UltraScale FPGA

•

All

Virtex UltraScale+ FPGA

•

All

Virtex UltraScale+ HBM

•

All

Virtex UltraScale+ 58G

•
Kintex FPGA

Kintex®-7

•

FPGA

XC7K70T, XC7K160T

Kintex UltraScale FPGA

•

XCKU025, XCKU035

Kintex UltraScale+ FPGA

•
Artix FPGA

Spartan-7

Alveo
Kria
Versal

XCKU3P, XCKU5P

Artix-7 FPGA

•

XC7A12T, XC7A15T, XC7A25T,
XC7A35T, XC7A50T, XC7A75T,
XC7A100T, XC7A200T

Spartan-7

•
•
•

XC7S6, XC7S15

•

All

Kintex UltraScale FPGA

•

All

Kintex UltraScale+

•

All

Artix-7 FPGA

•

All

Spartan-7

•

All

XC7S25, XC7S50

All

Kria

•

Kintex®-7 FPGA

XC7S75, XC7S100

UltraScale+ devices

•

All

All

N/A

Alveo

•

All

Kria

•

All

AI Core Series

•
•

VC1902
VC1802

Prime Series

•
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Note: The UltraScale+ device is supported in Vitis and Vivado platform board design flows.

Compatible Third-Party Tools
Table 2: Compatible Third-Party Tools
Red Hat
Linux

Red Hat
64-bit
Linux

SUSE Linux

Windows
10 32-bit

Windows
10 64-bit

Ubuntu

Mentor Graphics ModelSim
SE (2020.4)

N/A

Yes

N/A

N/A

Yes

N/A

Mentor Graphics Questa
Advanced Simulator (2020.4)

N/A

Yes

N/A

N/A

Yes

N/A

Cadence Incisive Enterprise
Simulator (IES) (15.20.083)

N/A

Yes

N/A

N/A

N/A

N/A

Cadence Xcelium Parallel
Simulator (20.09.006)

N/A

Yes

N/A

N/A

N/A

N/A

Synopsys VCS (R-2020.12)

N/A

Yes

N/A

N/A

N/A

N/A

The MathWorks MATLAB®
and Simulink® (R2020a,
R2020b, and R2021a )

Yes

Yes

Yes

N/A

Yes

Yes

Aldec Active-HDL (12)1

N/A

N/A

N/A

N/A

Yes

N/A

Aldec Riviera-PRO (2020.10)

N/A

Yes

N/A

N/A

Yes

N/A

Synopsys Synplify/Synplify
Pro (M-2017.03-SP1)3

Yes

Yes

N/A

N/A

Yes

N/A

Mentor Graphics Precision
RTL/Plus (2019.1.1)

Yes

Yes

Yes

Yes

Yes

N/A

Cadence Encounter
Conformal (9.1)4

Yes

Yes

Yes

N/A

N/A

N/A

OneSpin 360 (2016_12)

Yes

Yes

Yes

N/A

N/A

N/A

Third-Party Tool
Simulation

Synthesis2

Equivalence Checking

Notes:
1.

Support for Aldec simulators is offered by Aldec.

2.

Most Vivado IP can only be synthesized by Vivado synthesis, because the RTL source can include encrypted files. To
use this IP in a third-party synthesis flow, netlist can be exported from the Vivado tool in a suitable format for use in
the third-party synthesis project.

3.

Contact Synopsys for availability of Synplify Overlay or Service Pack.

4.

Cadence Encounter Conformal Support is for RTL2Gate using Synopsys Synplify only.

5.

Please refer to UG1483 for Vitis Model Composer OS support details.

Note: The versions listed in the above table are the minimum required versions to use with the Vivado
tools. Previous versions are not tested.
Note: Please contact simulation vendor to check if you need license for using advanced simulation
features.
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System Requirements
This section provides information on system memory requirements, cable installation, and other
requirements and recommendations.

System Memory Recommendations
For memory recommendations for the Vivado Design Suite tools, see Memory
Recommendations.
Operating Systems and Available Memory
The Microsoft Windows and Linux operating system (OS) architectures have limitations on the
maximum memory available to a Xilinx program. Users targeting the largest devices and most
complex designs might encounter this limitation. The Vivado Design Suite has optimized memory
and enabled support for applications to increase RAM memory available to Xilinx tools.

Cable Installation Requirements
Platform Cable USB II is a high-performance cable that enables Xilinx design tools to program
and configure target hardware.
Note: The Xilinx Parallel Cable IV is no longer supported for debugging or programming.
RECOMMENDED: To install Platform Cable USB II, a system must have at least a USB 1.1 port. For
maximum performance, Xilinx recommends using Platform Cable USB II with a USB 2.0 port.

The cable is officially supported on the 64-bit versions of the following operating systems:
• Windows 10
• Red Hat Linux Enterprise
• CentOS
• SUSE Linux Enterprise 12
Additional platform-specific notes are as follows:
• Root privileges are required.
• SUSE Linux Enterprise 11: The fxload software package is required to ensure correct Platform
Cable USB II operation. The fxload package is not automatically installed on SUSE Linux
Enterprise 11 distributions, and must be installed by the user or System Administrator.
For additional information regarding Xilinx cables, see the Platform Cable USB II Data Sheet
(DS593).
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Equipment and Permissions
The following table lists related equipment, permissions, and network connections.
Table 3: Equipment and Permissions Requirements
Item

Requirement

Directory permissions

Write permissions must exist for all directories containing design files to be edited.

Monitor

16-bit color VGA with a minimum recommended resolution of 1024 by 768 pixels.

Ports

To program devices, you must have an available parallel or USB port appropriate for your Xilinx
programming cable. Specifications for ports are listed in the documentation for your cable.
Note: Installation of the cable driver software requires Windows 10. If you are not using one of
these operating systems, the cables might not work properly.

Note: X Servers/ Remote Desktop Servers, such as Exceed, ReflectionX, and XWin32, are not supported.

Network Time Synchronization
When design files are located on a network machine, other than the machine with the installed
software, the clock settings of both machines must be set the same. These times must be
synchronized on a regular basis for continued proper functioning of the software.

Checking Required Libraries
There may be a requirement to install dependent libraries for certain Linux operating systems.
Please refer to AR#66184 on the Xilinx website on how to check which libraries are required to
run Vivado tools on Linux.
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Chapter 3

Obtain and Manage Licenses
Licensing Overview
Product Licensing Account Overview
When you purchase a design tool edition or IP product from Xilinx, you are purchasing a license
to use and receive updates for that product for one year. The license to use Xilinx design tools
and IP products is managed through the use of product entitlements. A product entitlement is
the determination of:
• Which product was purchased
• The number of seats purchased
• The license type (certificate based, floating, or node-locked)
• The product subscription period (product updates are provided throughout the year)
In addition to managing the product entitlements for your purchased design tools and IP, you can
also access product entitlements for No Charge or Evaluation products.
• Full and No Charge licenses have a subscription period of one year
• Design tools evaluations are for 30 days
• IP evaluations are for 120 days
Generating a license from a product entitlement results in one or more license keys being
generated by the website. When installed, the license keys enable the use of the design tools and
IP that were purchased or are being evaluated. Your product entitlements and resulting license
key files are managed in a product licensing account on the Xilinx website.
Product licensing accounts are specific to the individual listed on the Xilinx Software Purchase
Order, who is either the end-user or administrator of the design tools. All purchases made can be
managed in the same product licensing account if a single administrator is named. A company
site can have multiple accounts managed by different administrators. The latter is helpful if a site
has multiple design teams working on differing projects with different budget pools.
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Note: A license can be generated for a product entitlement that has expired; however, it only enables
product releases up to the subscription end date. Applying a product update made available after the
subscription end date of your license will result in a licensing error the next time the tool is used.

LogiCORE™ IP License Generation in the Xilinx Design Tools
Any LogiCORE IP and design tools entitlements you have purchased appear in your list of
entitled products when you log into the Product Licensing Site. Currently, all IP entitlements will
generate certificate-based licenses. Licenses for Evaluation and No Charge IP are available on the
site in a separate area. Licenses for all your certificate-based design tools and IP can now be
generated in one pass. They are emailed to you in a single license file.

What Happens to Your License Key File
Each time a license is generated for a product entitlement, a FLEXnet increment line and
corresponding package line is added to the license key file. When a license key file is modified to
add seats for an existing or new product entitlement, additional increment or package lines are
added to the license key file.
When a license key file is rehosted or is modified to delete seats or product entitlements, the
corresponding increment lines are regenerated or removed from the modified license key file.

User Type and Actions
There are three user types for the Product Licensing Site: customer account administrator, end
user, and no-charge user.
Customer Account Administrator
An example of a typical customer account administrator is a CAD tools manager. Every product
licensing account must have at least one customer account administrator. A customer account
administrator can manage more than one product licensing account.
The responsibilities as the customer account administrator include:
• Generating node-locked or floating licenses for Xilinx design tools and IP products.
• Adding and removing users from the product licensing account.
• Assigning administrative privileges to other users.
The original customer account administrator is the Ship To contact identified during the product
ordering process. That person receives an email with instructions on how to download and
license each purchased product. The customer account administrator must follow the link in the
email, to ensure access to the purchased products.
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End User
Adding end users to a product licensing account allows an engineer or design team member the
flexibility to manage and generate license keys on their own. The end user can generate license
keys for node-locked products entitlements within the account as well as evaluation and “no
charge” license keys for design tools and IP products. A customer account administrator can also
configure the end user account to allow an end user to generate floating licenses. An end user
cannot:
• View or generate floating license keys by default. This privilege can be assigned to them by
the customer account administrator.
• View the license keys generated by other users.
• Add or remove other users to or from the product licensing account.
No-Charge
No-Charge users can:
• Generate a 30-day free evaluation license key that enables Vivado ML Enterprise Edition.
• Generate a 30-day free evaluation license that enables Vitis™ HLS.
• Generate license keys for evaluation and no charge IP products.
All user types can download products electronically.
Note: A customer who is already licensed for a full version of a Xilinx Design Tools product edition can
evaluate other Xilinx Design Tools product editions or IP. These product entitlements are made available in
the same product licensing account.

Accessing the Xilinx Product Licensing Site
You can access the Xilinx Product Licensing Site in various ways depending upon the type of
license being generated.
If you purchased products which use certificate-based licenses, follow the link included in your
order confirmation email. It provides direct access to an account containing your product
entitlements.
• To evaluate the Vivado Design Suite products, go to the Vivado Design Suite Evaluation and
WebPACK page.
• To evaluate IP products, go to Intellectual Property page and follow the Evaluate link on the IP
product page of interest.
• To access the Product Licensing Site directly, go to https://www.xilinx.com/getlicense. By
accessing the site this way, you will be able to create certificate-based licenses as well as
perform license account management functions.
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Using the Xilinx Product Licensing Site
The Xilinx® Product Licensing site is an online service for licensing and administering evaluation
and full copies of Xilinx design tools and intellectual property (IP) products.
Using the Xilinx Product Licensing site, you can do the following:
• Create certificate-based licenses
• Manage licenses
• Review license order information
• Manage users

Changing Xilinx User Account Information
It is important to keep your Xilinx User Account up to date. As you change companies, addresses
or emails might change.

Modify Your Corporate Email Address
1. Go to www.xilinx.com.
2. Click Sign In.
3. Click Edit Profile.
4. Enter your new corporate email address in the Enter new Corporate email address box.
5. Click Update button for changes to take effect.

Certificate-Based Licensing
Xilinx enforces the Xilinx End-User License Agreement at run time in the Xilinx design tools using
certificate-based licensing.
A certificate, commonly referred to as a “license file (.lic)” is issued from the Xilinx Product
Licensing Site. The certificate is matched to a given machine, server or licensing dongle using
your entering host-id which uniquely identifies the machine. This license certificate must remain
present on the machine and in the license search path, because the Vivado tools need access to
this file to check for a valid license feature during run time.
Note: Flex-ID Dongle licensing for Xilinx Software is supported only on Windows platforms.

Certificate Licensing Terminology
• Host ID: An identifier, placed within certificate licenses, which binds the license to the
computer using this identifier. Typical identifiers are: Hard-drive volume ID, Ethernet port
MAC address, or USB Dongle ID.
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• Node-Locked License: A node-locked license allows for the use of a single seat of a product
entitlement on a specific machine.
• Floating License: A floating license resides on a network server and enables applications to
check out a license when they are invoked. At any one time, the number of licenses for
simultaneous users is restricted to the number of license seats purchased.
• License Rehosting: The act of changing the host ID of a generated license due to machine
hardware changes, hard-drive failure or the moving of a license from one machine to another.
• License Deletion: The act of removing a license from a machine, and having the entitlement
placed back into the Xilinx Product Licensing Account.
• Affidavit of Destruction: Click-through agreement by which you certify that the license file
(.lic) for a rehosted or deleted license will be destroyed and no longer used.

Installation Download Options
Xilinx Design Tools users have multiple choices for download and installation.
All Editions and download options are available on the Xilinx Downloads Website.
Xilinx introduced Vivado Lab Edition, which features a dedicated and streamlined environment
for programming and debugging devices in lab settings.
TIP: No license is required to use Vivado Lab Edition tools.

For users wishing to install one of the full Vivado Editions, there are three choices.
Vivado Design Suite - ML Editions:
• Xilinx Unified Installer 2021.1: Windows Self Extracting Web Installer
• Xilinx Unified Installer 2021.1: Linux Self Extracting Web Installer
• Vivado ML 2021.1: All OS Installer Single-File Download

Create and Generate a License Key File
For certificate-based licenses, as long as you know the Flexera Host ID (Ethernet MAC ID, Drive
Serial Number or Dongle ID) you want to lock your license to, you do not need to enter the Xilinx
License Management site from one of our utilities.
Note: The step-by-step instructions below are for generating a floating certificate-based license as this
process contains a superset of all other certificate-based license generation flows.

1. Go to Product Licensing.
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If prompted, sign in with your Xilinx credentials and confirm any necessary information to
continue.

• If you already have a Xilinx user account, enter your E-mail Address and password, and
then confirm your contact information is current.
• If you do not have an account, click the Create Account link and register.
• Provide the necessary info for Name and Address verification for the U.S Government
Export Approval form and click Next.
The Product Licensing page is displayed.

2. Select a product licensing account from the Account drop-down list.
Note: This selection is not available if you are entitled to evaluation or free products only.
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3. (Optional) Enter product voucher codes for design tools or IP product licenses purchased
with kits or for tools purchased from the Xilinx online store. If you have a product voucher
card, you can enter the voucher code on the card into the associated text field and click
Redeem Now.
Product vouchers for design tools and IP product licenses can be shipped with a Xilinx or
partner development board or design kit. This places the corresponding design tools or IP
product entitlement in the product entitlement table which you can use to generate a license
key.
4. (Optional) Add evaluation or No Charge IP product entitlements to the product entitlement
table.
To add Evaluation and No Charge IP to the list of product entitlements, click the Search Now
button in the Add Evaluation and No Charge IP Cores section of the page. This opens an IP
product finder tool.

5. Make your product selections from the Certificate-Based entitlement table.
The following types of product entitlements are available:
• Full (purchased)
• No Charge
Note: Full and No Charge licenses have a subscription period of one year.

• Evaluation
Note: Design tool evaluation is for 30 days and IP evaluations are for 120 days.

The Vivado Design Suite: 30-Day Evaluation License evaluation product entitlement
provides access to all the capabilities in the Vivado Design Tools. This product entitlement
is automatically included in your product licensing account.
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Products with a status of Current are within their warranty period. Products with a status of
Expired have a warranty period end date that has passed. If seats are available, licenses can
be generated for either Current or Expired product entitlements.
6. Select the number of seats required for each product license.
This is for floating licenses only. All node-locked licenses are for one seat. The number of
seats available for a product entitlement is automatically maintained by the system. The
Requested Seats field is populated, by default, with zero, although you are allowed to enter
any number up to the full number of seats remaining on the product entitlement. A product is
removed from the product entitlement table once all seats have been generated.
For design tools, available seats represents the number of seats available for licensing over
the total number of seats purchased. For IP, seats are managed according to the terms of the
site-wide license agreement.
7. Click the Generate License button corresponding with the type of license file you are
generating.
Note: Floating/server and node-locked/client licenses cannot be combined in the same license file.
Selecting an entitlement that contains only one license type causes the Generate button for the other
license type to become inactive.

A new window is displayed where you define the product and system that you are generating
the license for.

8. Enter system information.
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For floating certificate-based licenses, the first field is redundancy. A triple-redundant server
configuration, also known as a triad, provides a fail over for the license manager software. As
long as two of the three servers are running, the license manager can continue to run. This
does not apply to node-locked licenses. The system information is pre-populated in the Host
ID drop-down menu if you arrived at the Product Licensing Site from a link within the Vivado
License Manager.
a. If you do not have pre-populated system information, or if you want to add a different
host, click Select a Host and then click Add a Host.

b. Enter information about the host.
The Host ID value uniquely identifies the machine to which your design tools or IP is
licensed. You can choose a Host ID Type to be a MAC address, a hard drive serial number
or a dongle ID.
Note: Not all host ID types are supported for all operating systems. The easiest way to obtain your
host ID is to run Vivado License Manager on the machine that serves as the license host.

9. (Optional) Add a comment.
Adding a comment to the license key makes it easier for the administrator to track the
allocation of the design tools and IP product entitlements among users.
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10. Click Next.
11. Review your selections, and click Next.
12. Accept the licensing agreement.
Note: If you license IP products, you must accept the terms of the associated IP product EULAs before
the license file can be generated.

When you finish generating the licenses, you receive a confirmation message summarizing your
licensing activity.

You will receive an email from xilinx.notification@entitlenow.com with the license
file, which you must save to your machine.
TIP: If you do not receive your license by email, you can download it directly from the Product Licensing.
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Installing Your License Key File
Install Certificate-Based Node-Locked License Key File
After generating a license file, you will receive an email from ‘xilinx.notification@entitlenow.com’.
1. Save the license file (.lic) attached to the e-mail to a temporary directory on your local
system.
2. Run the Vivado License Manager:
• For Windows 10 or earlier: Select Start → All Programs → Xilinx Design Tools → Vivado
2021.1 → Manage Xilinx Licenses.
• For Windows 8.1: Run the Manage Xilinx Licenses app from the full listing of Apps on your
Start screen.
• For Linux: Type vlm in a command-line shell.
3. On the left hand pane of Vivado License Manager, expand Getting a License and select Load
License.
4. If you received a certificate license (.lic) file, click the Copy License button on the Load
License screen.
5. Browse to your license file (Xilinx.lic) and click Open.
This action copies the license file to the %APPDATA%\XilinxLicense (Windows) or
<Home>/.Xilinx directory of your computer where it will be automatically found by the
Xilinx tools.
6. Click OK.

Serving Certificate-Based Floating Licenses
For existing FLEXnet license servers serving certificate-based licenses, a common practice is to
copy the contents of the license file, mailed from xilinx.notification@entitlenow.com, into the
existing license file on your FLEXnet server.
Note: Restart the floating license server to ensure the new Xilinx licenses are enabled.

Serve New License Servers
1. Go to the Xilinx Downloads Website.
2. In License Management Tools, select and download the applicable Xilinx FLEXnet license
utilities for your server's operating system.
3. Unzip these utilities into a destination directory.
RECOMMENDED: Xilinx recommends you place this directory into your application search path
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4. After the FLEXnet utilities are installed, run the following commands to start the floating
license server:
• For Linux, enter <Server Tool directory>/lnx64.o/lmgrd.sh -c
<path_to_license>/<license file>.lic -l <path_to_license>/<log
filename>1.log.
• For Windows, enter <Server Tool directory>/lmgrd -c
<path_to_license>/<license_file>.lic -l <path_to_license>/
<log_filename>1.log..

Serve Client Machines Pointing to a Floating License
IMPORTANT! The following workflow is only applicable for Windows.
For Linux operating systems, licensing environment variables cannot be set using the Vivado License
Manager (VLM). The environment variable fields are read only, so they are grayed out and there are no Set
buttons. The environment variable must be set using the appropriate OS shell and commands.

1. Run the Vivado License Manager (VLM).
2. Under Manage License, click Manage License Search Path.
3. In the XILINXD_LICENSE_FILE field, enter the network path to the license server in the
<port>@<server> format.
4. Click Set. The default Xilinx port number is 2100.

Managing Licenses
Managing Licenses with the Vivado License Manager
The Vivado License Manager (VLM) is intended to assist with license generation for Certificatebased licenses only.
Vivado License Manager is installed with Vivado Edition and many standalone tool installations.
The following figure shows the VLM.
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Figure 1: Vivado License Manager

The typical tasks that Vivado License Manager is used for are:
• Obtaining A License: Choose from several license options and go to the Xilinx Product
Licensing Site to complete the license generation process.
• Viewing License Status: See which licenses are visible to the local machine. This is a useful
view for debugging licensing issues.
• Loading Licenses Onto a Local Machine: After a certificate license (.lic) file has been received,
it can be placed into the appropriate location on the machine. For step-by-step instructions,
see the Installing Your License key section for your license type below.
• Viewing and Setting (Windows) License Search Locations: Vivado tools will look in several
default locations to try to find authorization to run. If your license is located elsewhere on the
machine or on a floating license server, a path to that license must be specified.
RECOMMENDED: It is recommended that the XILINXD_LICENSE_FILE environment variable be used
to specify Xilinx license file locations. LM_LICENSE_FILE can also be used, but is mainly intended for
non-Xilinx or legacy license path use.
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Managing Licenses on the Xilinx Product Licensing
Site
The Xilinx Product Licensing site tracks the licenses that you have generated. To view all licenses
you generated in your product licensing account, select the Manage Licenses tab.
Figure 2: Manage Licenses

Information regarding the licenses in your product licensing account are displayed in a splitsection view. To view detailed information about the licenses in the detail view in the bottom
table, click a row in the master view in the top table. The detail view table displays:
• A list of product entitlements enabled by file.
• Comments associated with the file.
The detail view table gives you the ability to:
• Download (
• Email (

):

• View (

):

• Delete (

):

):

• Download (View EULA):
• Download your license file if it does not arrive through email.
• Email the license file emailed to you or another user.
• View the actual license file.
• Delete the license file. After a file is deleted the entitlement will then become available on the
Create New License page and can be regenerated for another host ID.
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• View the end user license agreement (IP only).

Modifying Licenses
To modify an existing certificated-based license, select the license file in the master view.
You can modify a certificated-based license by doing the following:
• Delete license files and place the entitlement back onto your account.
• Rehost or change node-locked or license server Host IDs.
• Add or remove seats to an existing license product entitlement.
• Add or remove product entitlements from a license key.

Delete Entire License File and Place Entitlement Back Onto Your Account
1. From the Manage Licenses Tab, select the license file you want to delete.
2. Click the Delete button (

) located below and to the left of the license file details.

3. Click Accept button to accept the Affidavit of Destruction.
All license seats in the entire license file are deleted, and the entitlements are returned to your
account.
Reclaiming Deleted License Components

A product entitlement is deleted when one of the following occurs:
• Changing the license server host for a license key file.
• Removing seats from an existing licensed product entitlement.
• Deleting product entitlements from a license key file.
When you delete seats or remove products from your certificate-based license files, the
entitlement is essentially “put back” or reallocated into your licensing account. You will find that
the number of entitled seats in the Create New Licenses tab of your account is incremented by
the same number of seats you deleted previously from existing license files.
Before the reallocation of entitlement occurs, you must first agree to an Affidavit of Destruction.
This legal agreement is required to ensure the deactivated product entitlements are no longer
being used.
The number of allocation operations is recorded for each user. Administrators are allowed to
reallocate product entitlements five times per major release. End users are allowed to reallocate
product entitlements three times per major release.
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Rehost: Change Node-Locked or License Server Host ID for a License File
1. From the Manage Licenses Tab, select the license file you wish to rehost.
2. Click Modify License.
The Modify License screen displays.
3. Go to System Information.
4. Change or add new Host ID and/or Host Name by using the drop-down list and text entry
boxes respectively.
5. Click Next button twice and then click Accept to accept the Affidavit of Destruction.

Add or Remove Seats to an Exisiting License Product Entitlement
For floating licenses, you will be able to change the Requested Seats field and add seats up to the
total number of seats available in your entitlement.
1. From the Manage Licenses tab, select the license file to which you wish to add or remove
seats.
2. Click Modify License.
The Modify License screen appears.
3. Go to Product Selection.
4. Click Next twice.
If you removed seats, accept the Affidavit of Destruction.
Note: No Affidavit of Destruction is required for adding seats.

Add or Remove Product Entitlements from a License Key File
1. From the Manage Licenses tab, select the license file to which you wish to add or remove
features/entitlements.
2. Click Modify License.
The Modify License screen appears.
3. Go to Product Selection.
4. Check boxes of any entitlements you want to add or remove from this license file.
5. Click Next button twice.
If you removed features, accept the Affidavit of Destruction.
Note: No Affidavit of Destruction is required for adding features.

Modifying a key file uses the same input form as when the license key file was created,
except that additional product entitlements of the same license type (floating or node-locked)
are made available for adding to the license file.
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Understanding Your Tool and IP Orders
The Orders tab displays information regarding the purchasing orders that created the
entitlements you see in this account.
• Xilinx order numbers are listed on the left panel of the screen.
• Order details populate on the right panel of the screen when you highlight a specific order.
• You might only select one order at a time.
• The order’s shipping address information is visible even when product is delivered
electronically.
Figure 3: Orders

Managing User Access to the Product Licensing Account
The Manage Users tab displays information regarding the user access to the product licensing
account. From this tab, you can add or remove users. The responsibility of administering a
product licensing account can be transferred or shared with another user.
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Figure 4: Manage Users

Add Users
1. Select the Manage Users tab.
2. To add a user to your product licensing account, do the following:
a. Enter the corporate email address of the new user.
Note: The email address you provide must be the same email address the user supplied or supplies
when creating their Xilinx account. If not, you might not be properly recognized when logging in.

If added users have already logged into the Product Licensing Site, their name appears in
the user list. If they have never been to the site, the words Not Yet Registered appears in
the space for their name. After they register, their name is filled in.
b. To grant the new user customer account administrative privileges, select Add as a full
administrator.
c. To grant the new user the ability to generate Floating License, select Allow Floating
Licenses. This option does grant full administrative privileges.
If you check Allow Floating Licenses only, the restriction on node-locked keys is lifted, but
the others remain. You cannot check both boxes because it is not allowed. Full
administrators already have floating license generation capability.
In some instances, a customer account administrator might wish to have design team
members administer license key files for their own use. By leaving both Add as full
administrator and Allow Floating Licenses check boxes unchecked, you grant the user the
following restricted privileges:
• User can generate node-locked license keys only.
• User can view and modify only those license key files they generated for themselves.
• User cannot manage users.
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Remove Users
1. Select the Manage Users tab.
2. To remove administrative or floating license generation privileges from a user, uncheck the
Administrator or Floating check box for that user.
3. To remove a user from a product licensing account, click the Delete button for that user.
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Chapter 4

Download and Installation
This section explains how to download and install the Vivado® Design Suite tools, which includes
the full complement of Vivado Design Suite tools for design, including C-based design with Vitis
HLS, implementation, verification, and device programming. Complete device support, cable
drivers, and documentation Navigator are included. Users can add Vitis Model Composer which
is a Xilinx toolbox for MATLAB and Simulink to design for AI Engines and Programmable Logic. If
you have been using Xilinx System Generator for DSP, you can continue development using Vitis
Model Compose.

Xilinx Unified Installer
Xilinx Unified installer allows users to install multiple Xilinx tools using single installer. Users can
install Vivado Design Environment, Vitis, Lab Edition, Hardware Server, On-premise install for
cloud deployment, Petalinux, Bootgen and Documentation Navigator using single installer.
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Figure 5: Product Installation

Xilinx Unified Installer is available to download on the Xilinx Downloads Website.

Download the Installation File
For the optimum download experience:
• Allow pop-up from https://www.o-ms.com/.
• Set security settings to allow for secure and non-secure items to be displayed on the same
page.
1. Go to the Xilinx Downloads Website.
2. Click an installation file to download it.
• To download a full edition of the Vivado Design Suite, choose from the following options:
○

Xilinx Unified Installer 2021.1: Windows Self Extracting Web Installer

○

Xilinx Unified Installer 2021.1: Linux Self Extracting Web Installer

○

Vivado ML 2021.1: All OS Installer Single-File Download

Note: The Full Edition installers work only on 64-bit machines.
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• To download the Vivado Lab Edition tools, select a version of 2017.1 or newer, and
download the file associated with the Vivado Lab Edition.
Related Information
Installation Download Options

Download Verification
After downloading the installation file, you can complete download verification to prove the
authenticity and integrity of the downloaded installation file with a fair degree of certainty. This
step is completely optional but highly recommended. You can skip this step and continue with
the installation.
• Authentication validates that downloaded file was created by the signee, in this case signee is
Xilinx Inc. In other words, it shows that downloaded file is not forged by a third party.
• Integrity validates that contents of downloaded file are not tampered by third party. In
summary, download verification allows users to validate if downloaded file indeed is prepared
by Xilinx and if the contents of the downloaded file have been altered or not.
The Digest, Signature and Public Key options are provided on download page for the purpose of
download verification.
There are two ways to verify the authenticity and integrity of downloaded files. You can choose
one or both of the following methods to ensure the authenticity and integrity of downloaded
files.
• Verify the Signature
• Verify the Digest
For both of the above methods, before you can verify and authenticate the downloaded file, you
must download, import, and trust the public key.

Download, Import, and Trust the Xilinx Public Key
1. Download the Xilinx public key.
a. Go to the Xilinx Downloads Website.
b. In Download Verification, click Public Key.
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This downloads xilinx-master-signing-key.asc.
c. Confirm the download and import of the Xilinx public key.
2. To import the key, enter the following command:
gpg --import ./xilinx-master-signing-key.asc
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3. Set the trust level to ultimate. This will allow verification of the key signed by Xilinx.
a. First, enter the following command to list the public keys:
gpg --list-keys

b. To specify the key to edit, enter the following command:
gpg --edit-key 0x85D4B4BB1D692FDB

c. Enter the following command to set the trust level for the legitimate key: trust.

UG973 (v2021.1) June 16, 2021
Vivado Design Suite 2021.1 Release Notes

Send Feedback

www.xilinx.com
36

Chapter 4: Download and Installation

d. Enter 5 at the prompt.

Now that you have downloaded, imported and trusted the Xilinx public key – you can ensure the
authenticity and integrity of the downloaded file by verifying the signature or verifying the
digest.
Note: You can pick one or both of methods to ensure the authenticity and integrity of downloaded file.
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Verify the Signature
In order to verify the downloaded file that matches its signature, download the signature file.
1. Go to the Xilinx Downloads Website.
2. In the Download Verification area, select Signature for the applicable download type.
3. Download and save the signature file.
4. Run the following command to verify the signature:
gpg -v --verify Xilinx_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.sig
Xilinx_Unified_20XX.Y_MMDD_HHMM_Lin64.bin

Verify the Digest
This is an alternative verification method to ensure the authenticity and integrity of the
downloaded file. This method uses the “digest” or “hash values” which is the output of various
cryptographic hash functions. The current digest file support MD5, SHA1, SHA256, SHA512
hashing algorithms.
1. Go to Xilinx Downloads Website.
2. In the Download Verification area, select Digest for the applicable download type.
3. Download and save the digest file.
4. After the digest file has been downloaded and stored, you need to first authenticate the
digest file to make sure that it is indeed coming from Xilinx Inc.
a. Run the following command to verify the signature that ensures that digest file is indeed
coming from Xilinx Inc.
Xilinx_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.digests
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5. After the authentication is done, verify the digest either by using hashing executable or
OpenSSL.
• To verify the digest using hashing executable – sha256, run the following command:
sha256sum -c Xilinx_Unified_20XX.Y_MMDD_HHMM_Lin64.bin.digests

Note: You can use other hashing executables as well such as md5sum, sha1sum, and sha512sum.

• To verify the digest using OpenSSL, run the following command:
openssl dgst -sha256 Xilinx_Unified_20XX.Y_MMDD_HHMM_Lin64.bin

Output of the command is a computed hash value that you need to compare to the
contents of the digest file.

Installing the Vivado Design Suite Tools
This section explains the installation process for all platforms for the Vivado Design Suite.

Installation Flow
Lab Edition, Full Product Download, or DVD
If you downloaded the Lab Edition or full product installation, decompress the file, and then run
xsetup (for Linux) or xsetup.exe (for Windows) to launch the installation.
RECOMMENDED: Xilinx recommends the use of 7-zip or WinZip (v.15.0 or newer) to decompress the
downloaded tar.gz file.
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Lightweight Installer Download
If you downloaded the lightweight installer, launch the downloaded file. You are prompted to log
in and use your regular Xilinx login credentials to continue with the installation process.
Note: On Linux the file is a .bin file and can be launched by running ./<name of the file>.bin.
Please ensure that you have changed the file permissions to execute.

After entering your login credentials, you can select between a traditional web-based installation
or a full install image download.
• Download and Install Now: Allows you to select specific tools and device families on following
screens, downloads only the files required to install those selections, and then installs them
for you.
• Download Image (Install Separately): Requires you to select a download destination and to
choose whether you want a Windows only, Linux only, or an install that supports both
operating systems. You also have an option to either download the full installer or download
only selected products. There are no further options to choose with the Full Image selection,
and installation needs to be done separately by running the xsetup application from the
download directory.
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Figure 6: Xilinx Unified Installer - Select Install Type

Prepare to Install the Tools
You must perform these actions prior to installation.
TIP: To reduce installation time, disable anti-virus software.

1. Check the links described in Important Information for any installation issues pertaining to
your system or configuration.
2. Ensure your system meets the requirements described in Chapter 2: Requirements and Setup.
3. Close all open programs.
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Run the Installation File
Use the installation file you downloaded to install the Vivado development environment.
1. Run the installation file, which opens the Unified 2021.1 Installer.
2. Click Next.
3. Enter your account credentials.
4. Select Download and Install Now, and then click Next.
5. Read and accept the license agreements.
• To indicate that you accept the Xilinx Inc. End User License Agreement, click I Agree.
• To indicate that you understand and accept the WebTalk Terms and Conditions, click I
Agree.
• To indicate that you accept the Third Party Software End User License Agreement, click I
Agree.
6. After accepting all license agreements, click Next.
7. Select a product to install.
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8. Select the edition or standalone tool to install.

9. Customize the installation by choosing the design tools, device families, and installation
options. Selecting only what you need helps minimize the download and installation for each
product.
To add to this installation later:
• For Windows, click the Start menu, and select Xilinx Design Tools → Vivado <version> →
Add Design Tools or Devices.
• For Linux, launch Vivado → Help → Add Design Tools or Devices.
Note: Tools and devices can also be added from the Xilinx Information Center (XIC).

10. Read and accept the license agreements.
• To indicate that you accept the Xilinx Inc. End User License Agreement, click I Agree.
• To indicate that you understand and accept the WebTalk Terms and Conditions, click I
Agree.
• To indicate that you accept the Third Party Software End User License Agreement, click I
Agree.
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11. After accepting all license agreements, click Next.

12. Click Next.
13. Select the installation directory.

CAUTION! The installation directory path must not contain any spaces.

14. (Optional) Select shortcut and file association options.
15. Click Next.
An Installation Summary window is displayed, describing the following information:
• Devices
• Design tools
• Installation options
• Installation locations
• Download locations
• Disk space requirements
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16. After reviewing the installation summary, click Install.

Adding Additional Tools and Devices
You can incrementally add additional tools, devices or even upgrade Vivado editions post-install.
This is useful for users that have chosen to install a subset of devices and/or tools.
To add new tools or devices:
• For Windows clients, click the Start menu, and select Xilinx Design Tools → Vivado <version>
→ Add Design Tools or Devices.
• For Linux clients, select Vivado → Help → Add Design Tools or Devices.
If you have installed the Vivado ML Standard or ML Enterprise Edition, you are presented with
the option to upgrade the edition.
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Figure 7: Vivado Design Suite Upgrade - Select Edition

Based on the above selection, you are presented with all available tools and devices that can be
added to the current installation.
You can also add tools or devices from the Xilinx Information Center (XIC).

Resolve Internet Connection Issues
The installer connects to the Internet through the system proxy settings in Windows. These
settings can be found in Control Panel → Network and Internet → Internet Options. For Linux
users, the installer uses Firefox browser proxy settings (when explicitly set) to determine
connectivity.
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Figure 8: Internet Connectivity Message Example

If there are connectivity issues, verify the following:
1. If you are using alternate proxy settings to the ones referred to, click the Change Proxy
Settings button to specify the settings.
2. Check whether your company firewall requires a proxy authentication with a user name and
password. If so, click the Change Proxy Settings button in the dialog box above.

3. For Linux users, if either the Use System settings or the Auto detect settings option is
selected in the Firefox browser, then you must manually set the proxy in the installer.

Core/CPUs Setting and Disk Usage Settings
1. Core/CPUs Setting and Disk Usage Settings:
• CPU bandwidth can be modified for the download and installation in the CPU/Core
settings under Preferences.
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• Disk Usage will be optimized by default during the installation. Disk usage settings can be
modified in Preferences.

Installing Cable Drivers
On Windows, Install Cable Drivers is an optional selection in the installer.
For Linux, because root or sudo access is required to install drivers, this option has been removed
from the Linux installer beginning in Vivado 2015.4. The general Vivado installer can now be run
on Linux without root or sudo privileges. To install cable drivers on Linux, there is now a script
that must be run as root or sudo post-installation.
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• Script Location: <Vivado Install Dir>/data/xicom/cable_drivers/lin64/
install_script/install_drivers/
• Script Name: install_drivers

Install Cable Drivers
1. To install the Windows driver, do the following:
a. Run the following commands in an Administrator command prompt.
cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64
install_drivers_wrapper.bat %log_dir% %log_dir%
Note:

• Set or replace %VIVADO_INSTALL_DIR% with the location of your install directory.
• Replace %log_dir% with the location of the log directory.
Note: If %log_dir% is not specified, a file named install_drivers_wrapper.log will be
placed under %VIVADO_INSTALL_DIR%.

2. To install the Linux driver, do the following:
a. Enter the following commands as root:
${vivado_install_dir}/data/xicom/cable_drivers/lin64/install_script/
install_drivers/install_drivers
Note: Replace ${vivado_install_dir} with the location of your Vivado install location.
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Using Download Image (Install Separately) Option
The Download Image (Install Separately) option can be used to download the installer image and
then install at a later date.

1. Provide the destination path (which does not have any other files) and choose the platform
for which the installer is desired. Zip archive can be selected to have a zip file of the same
installer.
2. Select the image contents.
• Full Image: Download the entire installer.
• Selected Product Only: Download only the files necessary for the selected tools/devices.

Uninstall Cable Drivers
• To uninstall the cable driver on a Windows client, run the following commands in an
Administrator command prompt:
cd %VIVADO_INSTALL_DIR%\data\xicom\cable_drivers\nt64 wdreg -inf %cd%
\xusbdrvr.inf uninstall net stop XilinxPC4Driver del %WINDIR%
\system32\drivers\windrvr6.sys del %WINDIR%\system32\drivers\xusb*.sys
del %WINDIR%\system32\drivers\xpc4drvr.sys
Note: Set or replace %VIVADO_INSTALL_DIR% with the location of your install directory.
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• To uninstall the products on a Linux client, run the following commands as root:
rm -f /etc/udev/rules.d/52-xilinx-digilent-usb.rules rm -f /etc/udev/
rules.d/52-xilinx-ftdi-usb.rules rm -f /etc/udev/rules.d/52-xilinxpcusb.rules

Uninstalling the Vivado Design Suite Tool
IMPORTANT! Before uninstalling, make sure to have moved any project files you want to keep outside
your Xilinx installation directory structure, or they will be deleted.

Xilinx Information Center and Documentation Navigator are not removed during uninstallation.
Both are intended to be standalone applications common to multiple versions of Xilinx tools.
If the applications are no longer required, they must be uninstalled separately through the
corresponding entry in the Start Menu program group, or for Windows, use the Uninstall or
change a program control panel option.

Uninstall the Vivado Design Suite Tool
IMPORTANT! Before uninstalling, make sure to have moved any project files you want to keep outside
your Xilinx installation directory structure, or they are deleted.

1. To uninstall any Xilinx product, select the Uninstall item from that product’s Start Menu
folder.
For instance, to uninstall Vivado Design Suite: Edition, select Start → All Programs → Xilinx
Design Tools → Uninstall 2021.1.
If you do not have a program group entry, use the command line option to uninstall:
<install_path>\.xinstall\Vivado_2021.1\xsetup.exe -Uninstall
Alternatively, use the corresponding entry in the Uninstall or change a program control panel
option.
2. To uninstall any Xilinx product on a Linux client, select Applications → Xilinx Design Tools →
Uninstall 2021.1.

Network Installations
Installing to a network location provides a way for client machines to access the design tools by
pointing to it on the network drive. To run the design tools on the network, the client machines
must be set up correctly to ensure the environment variables, registry, and program groups all
point to the network. The following sections describe the procedure for network setups.
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Install the Vivado Design Tools on a Linux Client Network
You must source settings64.(c)sh from the area in which the design tools are installed. This
sets up the environment to point to this installed location.
1. To run the design tools from a remotely installed location, run an X Windows display
manager, and include a DISPLAY environment variable.
2. Define DISPLAY as the name of your display.
DISPLAY is typically unix:0.0. For example, the following syntax allows you to run the tools
on the host named bigben and to display the graphics on the local monitor of the machine
called mynode.
setenv DISPLAY mynode:0.0
xhost = bigbenPC Clients

Install the Vivado Design Tools on a Microsoft Windows Client
Network
1. Install design tools to a PC network server.
Make sure your users know the location of the design tools and have access to the
installation directory, and they have Administrator privileges for the following steps.
2. From the local client machine, browse to the following directory:
network_install_location\.xinstall\Vivado_<version> and run the program
networkShortcutSetup.exe.
Running this program sets up the Windows settings batch files and Program Group or
Desktop shortcuts to run the Xilinx tools from the remote location.
3. From the client machine, launch the Vivado Design Suite tools by clicking the Program Group
or Desktop shortcuts, or by running the applications on the network drive.

Install to a Mounted Network Drive
Xilinx design tools are designed to be installed in a directory under ROOT (typically C:\Xilinx).
The installer normally presents this option when installing to a local driver.
To work around this issue, either specify a UNC path (for example, \\network_loc\Xilinx\)
or define your target installation directory as \Xilinx under the network mount point (For
example: N:\Xilinx).
Windows 7 default security levels do not allow you to select remote mapped drives. To install
Xilinx Design Tools on remote mapped drives, you must change your account control settings
using the following steps:
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1. Open the Windows Control Panel, from the Windows Start menu, and select User Accounts.
If your Control Panel uses Category View, click User Accounts on two successive screens.
2. Click Change User Account Control settings and allow the program to make changes.
3. Click and slide the slide-bar down to the second to lowest setting (as seen in the following
figure).
4. Click OK.

RECOMMENDED: Xilinx recommends that you revisit this procedure to restore your settings to their
previous state after installation.
Note: You are not able to browse to the remote mapped drives using the Xilinx installer. You need to
manually type in your installation path which contains a mapped network drive.

Batch Mode Installation Flow
The installer can run in an unattended batch process. To run the installer unattended, you must
do one of the following.
• Specify a standard edition and installation location
• Include a configuration file that provides the installer with the install location and the tools,
devices, and options you want to install
RECOMMENDED: Generate this reference for each new release, so that new devices, tools, options, or
other changes will be accounted for in your options file.
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To begin using batch mode, open a command shell, and change to the directory where you have
stored your extracted installer.
For Windows, open the command window with administrator privileges, and run xsetup.bat,
found in the \bin directory, and not xsetup.exe with the options below.

Generate a Configuration File
1. Run xsetup -b ConfigGen.
This will put you in an interactive mode where you will see the following menu:

Type 2, and then press Enter.
Select an edition, and then press Enter.

2. After you make a selection, you will be prompted with the location/file name for your
configuration file and the interactive mode exits. Below is a sample Vivado ML Enterprise
Edition configuration file:
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Each option in the configuration file matches a corresponding option in the GUI. A value of 1
means that option is selected; a value of 0 means the option is unselected.

Running the Installer
After editing your configuration file to reflect your installation preferences, you can run the
installer. As part of the command line installer, you must indicate your acceptance of the Xilinx
End-User License Agreement and Third Party End-User License Agreement, and confirm you
understand the WebTalk Terms and Conditions.
WebTalk Terms and Conditions
The WebTalk Terms and Conditions, which you must agree to when running the installer, is
below:
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By indicating I Agree, I also confirm that I have read Section 13 of the terms and conditions
above concerning WebTalk and have been afforded the opportunity to read the WebTalk FAQ
posted at https://www.xilinx.com/webtalk. I understand that I am able to disable WebTalk later if
certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by
uninstalling the Software or using the Software on a machine not connected to the Internet. If I
fail to satisfy the applicable criteria or if I fail to take the applicable steps to prevent such
transmission of information, I agree to allow Xilinx to collect the information described in Section
13(a) for the purposes described in Section 13(b).
When using the command line, use the command-line switch, -a or --agree, to indicate your
agreement to each of the above. If one of the above is left out of the list, or the agree switch is
not specified, the installer exits with an error and does not install.
Batch Mode Installation Using Single-File Download
This is an example of the command line for a typical new installation using a configuration file.
xsetup --agree XilinxEULA,3rdPartyEULA,WebTalkTerms
--batch Install --config install_config.txt

If you want to use one of the Xilinx default edition configurations, you do not have to specify the
--config option, but since the destination directory is included in the configuration file, you
will be required to specify this on the command line.
xsetup --agree 3rdPartyEULA,WebTalkTerms,XilinxEULA
--batch Install --edition "Vitis Unified Software Platform" --location "/
home/Xilinx"

The above command uses the default configuration options for the edition specified. To see the
default configuration options, use the –b ConfigGen mode as described above. The batch
mode of the installer can also uninstall and upgrade (add additional tools and devices). For the full
list of the options in the installer batch mode, run xsetup -h or xsetup --help.

Batch Mode Installation Using Web Installer
Command line based Web-Installer is a great way to enhance the productivity for installing Xilinx
Vivado tools. It includes all the features as GUI Web-Installer and it allows you to fully script your
installation process. Command line based Web-Installer uses secure token exchange mechanism
to validate the user accounts.

Extract Web Installer Batch Mode Client
Use following command to extract the batch mode client on your machine.
<Download Dir>/Xilinx_Unified_202X.Y_MMDD_HHMM_Lin64.bin --keep --noexec -target <WI Client Dir>
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Example Command:

Note: For Windows, open the command window with administrator privileges and run the xsetup.bat file,
found in the \bin directory, and not xsetup.exe.

For batch mode installation on windows, run following command.
Windows: <Download Dir>/Xilinx_Unified_Web_202X.Y_MMDD_HHMM_Win64.exe -gm2 nr -InstallPath="<WI Client Dir>" e.g.
Xilinx_Unified_2021.1_0616_2119_Win64.exe -y -gm2 -nr -InstallPath="C:\Temp
\wi"

Acquire Authentication Token
To minimize the user interaction, we will use secure token mechanism to authenticate the users.
First, we need to acquire an authentication token (stored in a text file) that will be used by the
web installer to authenticate the user before downloading/installing the tool.
This authentication token will need to be acquired (generated) at least once and will expire after
7 days. You need to generate/acquire new token after it is expired.
• Use following command to generate authentication token:

• It will ask for Xilinx Account user ID and password before generating authentication token.

Web Installer Download and Install
Use following command to download and install using command line web installer.
./xsetup -b Install -a XilinxEULA,3rdPartyEULA,WebTalkTerms -c
<path_to_configuration_file>

Example Command:
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Updates:
Updates to your existing install can only be installed using a full image (SFD) or via the
notification in XIC. We currently do not support updates to existing installer via Web Installer.

Obtaining Quarterly Releases
Xilinx periodically releases tools and tools updates which contains device support updates, new
features and bug fixes. The following sections describe how to obtain updates through the Xilinx
Information Center.

Xilinx Information Center
Xilinx Information Center (XIC) is the next generation replacement of XilinxNotify. This
functionality resides in the task bar (Windows) and periodically checks for new releases and
updates from Xilinx. Users can view and dismiss notifications as well as update installations.
In addition, XIC now includes a cockpit from which you can manage all of your Xilinx tool
installations. Update, check licenses or uninstall all from the new Manage Installs tab as shown in
the following figure.
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Figure 9: Xilinx Information Center (XIC)
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WebTalk
The WebTalk feature helps Xilinx® understand how you use Xilinx FPGA devices, software, and
intellectual property (IP). The information collected and transmitted by WebTalk allows Xilinx to
improve the features most important to you as part of our ongoing effort to provide products
that meet your current and future needs. When enabled, WebTalk provides information on your
use of the Vivado® Design Suite tools, Vitis, and PetaLinux.

WebTalk Participation
Your participation in WebTalk is voluntary except when a paid license is not found.
In these cases, WebTalk data collection and transmission always occurs, regardless of your
preference settings. For all other cases, data is not transmitted if you disable WebTalk.
The following table summarizes WebTalk behavior for data transmission to Xilinx from your postroute design, based on your Xilinx license, WebTalk install preference, and user preference
settings.
Table 4: WebTalk Behavior for Bitstream Generation or Route Design Flow
License

WebTalk Install
Preference Selected as
"Enabled"

WebTalk User
Preference Selected as
"Enabled"

Send WebTalk Data to
Xilinx

WebPACK

X

X

Yes

Edition License

No

X

No

Edition License

Yes

No

No

Edition License

Yes

Yes

Yes

Note: If the device is a WebPACK device, the Tools first look for a WebPACK license.
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Setting WebTalk Install Preference
You can enable or disable WebTalk globally during or after installation as described below. During
installation you can enable or disable WebTalk installation options by checking or unchecking the
Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for
WebPACK license) checkbox.
Figure 10: WebTalk Install Options

You can enable or disable WebTalk installation options using the Tcl command
config_webtalk:
config_webtalk -install on|off

• on: Turns WebTalk on for the installation.
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• off: Turns WebTalk off for the installation.
Install settings are saved in the following locations:
• Windows: <install dir>/vivado/data/webtalk/webtalksettings
• Linux: <install dir>/vivado/data/webtalk/webtalksettings
Note: You need administrator privileges to write to the install location.

Setting WebTalk User Preferences
You can enable or disable WebTalk user options by selecting Tools → Settings. In the Settings
dialog box, click the WebTalk category as shown in the following figure.
Figure 11: WebTalk User Preferences

After installation, you can enable or disable WebTalk user options using the config_webtalk
Tcl command:
config_webtalk -user on|off
• on: Turns WebTalk on for the current user.
• off: Turns WebTalk off for the current user.
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User settings are saved in the following location:
• Windows: <%APPDATA%>\Xilinx\Common\<version>\webtalk
where:
<%APPDATA%> is:
C:\Users\<user>\AppData\Roaming
• Linux: <%APPDATA%>/.Xilinx/Common/<version>/webtalk
where:
<%APPDATA%> is:
/home/<user>

Checking WebTalk Install and User
Preferences
You can also use the config_webtalk Tcl command to check the current status of WebTalk
settings. The command line option -info reports the values for the install setting and the user
setting:
config_webtalk -info

Types of Data Collected
WebTalk does not collect your design netlist or any other proprietary information that can be
used to reverse engineer your design. The data Xilinx collects through WebTalk includes:
• Software version
• Platform information
For example, operating system, speed and number of processors, and main memory.
• Unique project ID
• Authorization code
• Date of generation
• Targeted device and family information
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For more information on the type of data that is collected, see the Xilinx Design Tools WebTalk
page. To see the specific WebTalk data collected for your design, open the
usage_statistics_webtalk.xm file in the project directory. You can also open the
usage_statistics_webtalk.html file for easy viewing of the data transmitted to Xilinx.
Additionally, additional data collection files for sub-flows in the Xilinx tools are also generated
which include:
• usage_statistics_ext_xsim.xml
• usage_statistices_ext_labtools.xml
• usage_statistics_ext_vitis.xml
• usage_statistics_ext_petalinux.xml (along with corresponding HTML files)

Transmission of Data
WebTalk is invoked after bitstream or route design compilation. WebTalk bundles the collected
data in an usage_statistics_webtalk.xml file and sends this file to Xilinx by https
(hypertext transfer protocol secure) post. Every new compilation for a given design overwrites
the previous usage_statistics_webtalk.xml file. WebTalk also writes an HTML file
equivalent usage_statistics_webtalk.html file for easy viewing of the data
transmitted to Xilinx. WebTalk also writes to the vivado.log (or runme.log) file that contains
additional information about whether the file was successfully transmitted to Xilinx.
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Appendix A

Additional Resources and Legal
Notices
Xilinx Resources
For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Documentation Navigator and Design Hubs
Xilinx® Documentation Navigator (DocNav) provides access to Xilinx documents, videos, and
support resources, which you can filter and search to find information. To open DocNav:
• From the Vivado® IDE, select Help → Documentation and Tutorials.
• On Windows, select Start → All Programs → Xilinx Design Tools → DocNav.
• At the Linux command prompt, enter docnav.
Xilinx Design Hubs provide links to documentation organized by design tasks and other topics,
which you can use to learn key concepts and address frequently asked questions. To access the
Design Hubs:
• In DocNav, click the Design Hubs View tab.
• On the Xilinx website, see the Design Hubs page.
Note: For more information on DocNav, see the Documentation Navigator page on the Xilinx website.

References
These documents provide supplemental material useful with this guide:
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1. UltraFast Design Methodology Guide for Xilinx FPGAs and SoCs (UG949)
2. UltraFast Vivado HLS Methodology Guide (UG1197)
3. UltraFast Embedded Design Methodology Guide (UG1046)
4. Vivado Design Suite User Guide: Logic Simulation (UG900)
5. Vivado Design Suite User Guide: High-Level Synthesis (UG902)
6. Vivado Design Suite User Guide: Dynamic Function eXchange (UG909)
7. Vivado Design Suite Tutorial: Dynamic Function eXchange (UG947)
8. Vivado Design Suite User Guide: Hierarchical Design (UG905)
9. Vivado Design Suite User Guide: Model-Based DSP Design Using System Generator (UG897)
10. Vivado Design Suite User Guide: Implementation (UG904)
11. Vivado Design Suite User Guide: Power Analysis and Optimization (UG907)
12. IP Release Notes Guide (XTP025)
13. Platform Cable USB II Data Sheet (DS593)
14. Xilinx Design Tools WebTalk page
15. Vivado QuickTake Video Tutorials
16. Vivado Design Suite Documentation
17. PS and PL-Based 1G/10G Ethernet Solution (XAPP1305)
18. Secure Boot of Zynq-7000 SoC (XAPP1175)
19. Model Composer User Guide (UG1262)
20. PetaLinux Tools Documentation: Reference Guide (UG1144)

Training Resources
Xilinx provides a variety of training courses and QuickTake videos to help you learn more about
the concepts presented in this document. Use these links to explore related training resources:
1. Designing FPGAs Using the Vivado Design Suite
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Please Read: Important Legal Notices
The information disclosed to you hereunder (the "Materials") is provided solely for the selection
and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are
made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND
CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY
PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including
negligence, or under any other theory of liability) for any loss or damage of any kind or nature
related to, arising under, or in connection with, the Materials (including your use of the
Materials), including for any direct, indirect, special, incidental, or consequential loss or damage
(including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any
action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx
had been advised of the possibility of the same. Xilinx assumes no obligation to correct any
errors contained in the Materials or to notify you of updates to the Materials or to product
specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of
Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at https://
www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained
in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or
for use in any application requiring fail-safe performance; you assume sole risk and liability for
use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can
be viewed at https://www.xilinx.com/legal.htm#tos.
AUTOMOTIVE APPLICATIONS DISCLAIMER
AUTOMOTIVE PRODUCTS (IDENTIFIED AS "XA" IN THE PART NUMBER) ARE NOT
WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS
THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262
AUTOMOTIVE SAFETY STANDARD ("SAFETY DESIGN"). CUSTOMER SHALL, PRIOR TO USING
OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST
SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION
WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO
APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.
Copyright
© Copyright 2012-2021 Xilinx, Inc. Xilinx, the Xilinx logo, Alveo, Artix, Kintex, Spartan, Versal,
Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the
United States and other countries. All other trademarks are the property of their respective
owners.
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